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Overview

• TritonEd (UCSD’s previous LMS) allowed uploading a spreadsheet of 
text to its gradebook, but the Canvas gradebook only allows numbers.

• We’ll use a Canvas add-on to upload a spreadsheet of text.
• For students, it shows as comments in the gradebook (rather than scores).

• For instructors, it shows as SpeedGrader Assignment Comments.



Part 1. Overview of Workflow
(based on correspondence with Ed Ruiz, ITS)

Add “Submissions Comments” tool to your Canvas class

Workflow for each exam:
• Download roster from Canvas
• Make EXCEL spreadsheet of seat/student assignments
• Upload spreadsheet to Canvas
• Student and instructor views of seat assignments in Canvas
• Changing seat assignments after they’re uploaded

Later: Seating maps; manual & random seat assignments; exam logistics



Add Canvas tool: Submission Comments

• This tool will let us upload a spreadsheet of students and their seat 
assignments to Canvas.

• It needs to be added to each course you’ll use it in.



Add Canvas tool: Submission Comments

Go to your
course

In your course’s menu,
pick “Modules” Click on +Module



Add Canvas tool: Submission Comments

Enter a module name, “Admin Tools”

Click on:  Add Module



Add Canvas tool: Submission Comments

Use + to add an item
to the module



Add Canvas tool: Submission Comments

Select “External Tool”

Scroll to select
“Submission Comments”

Click on:  Add Item

Selecting it will fill in URL



Add Canvas tool: Submission Comments

Don’t publish the module!

It’s just for instructors/TAs, 
not students.

It will work for you without 
being published.



Preparing seat assignment spreadsheet

• Download roster from Canvas gradebook

• Use roster to make spreadsheet of seat assignments

• Create Canvas Assignment “Midterm 1 Seat Assignment”

• Upload spreadsheet to the Canvas Assignment



Download roster
Grades screen: Actions → Export

• Go to Grades screen
On Actions menu: Export

• That downloads a file to 
your computer:
2021-10-09T2230_Grades-
MATH283_FA21_A00.csv

• Optionally rename it, e.g.:
canvas_roster_mt1.csv



Preparing seat assignment spreadsheet

• Download roster from Canvas gradebook

• Use roster to make spreadsheet of seat assignments

• Create Canvas Assignment “Midterm 1 Seat Assignment”

• Upload spreadsheet to the Canvas Assignment



Entering seats in EXCEL

Open the roster file



Entering seats in EXCEL Keep first 4 columns:
Student
ID
SS User ID
SS Login ID

Optional: Keep 5th column
Section

Select and delete
all other columns



Entering seats in EXCEL Keep first 4 columns:
Student
ID
SS User ID
SS Login ID

Optional: Keep 5th column
Section

Select and delete
all other columns



Entering seats in EXCEL

Enter “Comments”
at the top of the column



Entering seats in EXCEL

Enter seat assignments
for each student in the
“Comments” column

Later: Random seats 
based on seat maps



Entering seats in EXCEL

Student with special
arrangements



Entering seats in EXCEL

Staff with student access
to class; may not want
to assign seats to them



Entering seats in EXCEL

“Test Student”
Enter fake seat to test
the student view in Canvas



Entering seats in EXCEL

For exam in 2 rooms,
put room and seat #
into the comment



Entering seats in EXCEL

Save in CSV format
(Comma-separated values)

EXCEL:
• File → Save As…
• Pick CSV for the File format

Google Sheets:
• File → Download → Comma-separated values

Numbers:
• File → Export To → CSV…



Preparing seat assignment spreadsheet

• Download roster from Canvas gradebook

• Use roster to make spreadsheet of seat assignments

• Create Canvas Assignment “Midterm 1 Seat Assignment”

• Upload spreadsheet to the Canvas Assignment



Create Canvas Assignment Group (optional)

Click on:  +Group



Create Canvas Assignment Group (optional)

Enter group name
“Seat Assignments”
and “0” for percentage

Click on:  Save



Create Canvas Assignment (mandatory)
“Midterm 1 Seat Assignment”

Click on  +Assignment



Create Canvas Assignment (mandatory)
“Midterm 1 Seat Assignment”

Enter a title
“Midterm 1 Seat Assignment”

Enter a description (optional)

Keep scrolling for more 
settings  (next slide)



Create Canvas Assignment (mandatory)
“Midterm 1 Seat Assignment”

Set all five of these:

(optional/may vary)



Create Canvas Assignment (mandatory)
“Midterm 1 Seat Assignment”

Use   Save & Publish

• It must be published to
upload the spreadsheet.

• After uploading, unpublish 
to hide the seat assignments



Create Canvas Assignment (mandatory)
“Midterm 1 Seat Assignment”

Assignment successfully created
and published



Preparing seat assignment spreadsheet

• Download roster from Canvas gradebook

• Use roster to make spreadsheet of seat assignments

• Create Canvas Assignment “Midterm 1 Seat Assignment”

• Upload spreadsheet to the Canvas Assignment



Uploading spreadsheet to Canvas

Go back to Modules screen
Click on:  Submission Comments



Uploading spreadsheet to Canvas

Select Canvas Assignment
“Midterm 1 Seat Assignment”



Uploading spreadsheet to Canvas

Select Canvas Assignment
“Midterm 1 Seat Assignment”

Choose the CSV file to upload

Click on: Preview Assignment Comments



Uploading spreadsheet to Canvas

Scroll through to verify it uploaded 
correctly

This is the ONLY chance to see
all seat assignments at once
in Canvas. You’ll still need your 
separate spreadsheet.



Uploading spreadsheet to Canvas

After verifying the upload, click on:
Add Comments to Students



Students: View seat assignment

Click on comment bubble
to reveal seat assignment

Look for “Midterm 1 Seat 
Assignment”

Students: Go to Grades



Students: View seat assignment

Seat assignment!



Sample Canvas Announcement / instructions
Midterm 1 in two rooms

Assigned seats for Midterm 1 have been posted, and some students 
will be in a second room. Please view your room and seat 
assignment as follows:

• Open this class in Canvas and click on Grades in the course menu

• Click on the comments icon for Midterm 1 Seat Assignment

• Note your assigned room and seat, e.g., Center 109, Seat H-5

• Seat number map for the regular classroom Center 109 [link]
Seat number map for the second classroom Center 105 [link]



Sample Canvas Announcement / instructions
Midterm 2 in one room with new seats

Assigned seats for Midterm 2 have been posted. They are different 
than on Midterm 1, and everyone will be in the regular classroom, 
Center 109; we are not using a second classroom. Please view your 
seat assignment as follows:

• Open this class in Canvas and click on Grades in the course menu

• Click on the comments icon for Midterm 2 Seat Assignment

• Note your assigned seat, e.g., Seat H-5

• Seat number map for Center 109 [link]



In addition to Canvas Announcement

If changing seat assignments for each exam, you can
unpublish “Midterm 1 Seat Assignment”
when you publish “Midterm 2 Seat Assignment”

so that they only see the current exam’s seat assignment.



Instructors: View seats after uploading

Go to Assignments screen and click on
Midterm 1 Seat Assignment



Instructors: View seats after uploading

Click on:  SpeedGrader

Only shows if assignment is Published.
If you just published it, you may have 
to refresh the screen (or leave it and 
come back) for SpeedGrader to show.



Instructors: View seats after uploading

Use arrows/menu to go 
through students 1-by-1

Seat assignment is listed
as a “comment”



Instructors: Minor edits after uploading
(changing just a few seats)

Then write new comment

Use ⨉ to delete the
old comment (otherwise 
they’ll see both the old 
and new comment)

Also make corresponding 
change in spreadsheet, 
and email student



Instructors: Major changes
(e.g., exam moved to new room)

• If you upload twice to the same assignment, students will see 
BOTH sets of comments, which may be confusing



Instructors: Major changes
(e.g., exam moved to new room)

• If you upload twice to the same assignment, students will see 
BOTH sets of comments, which may be confusing
• Delete or unpublish original Canvas assignment

Midterm 1 Seat Assignment
• Redo process from scratch with a new assignment name like

Updated Midterm 1 Seat Assignment
• Notify your class about the change and that they need to look up 

their new seat assignment.



Next up: Seating charts
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Part 2. Seating Charts

• Getting seating charts
• Special requests: accommodations, left-handed seats, … (Part 1)
• Every other seat, two rooms, etc.
• Random seat assignments
• Special requests (Part 2)



Getting seating charts
PDF seating charts (Registrar-controlled rooms)

BLINK: Instruction → Classroom Details
https://blink.ucsd.edu/faculty/instruction/tech-guide/classroom/details.html

SOLIS 104 (excerpt)

https://blink.ucsd.edu/faculty/instruction/tech-guide/classroom/details.html


Getting seating charts
EXCEL spreadsheets of seat numbers (large rooms)

Academic Integrity Office
• https://academicintegrity.ucsd.edu/take-

action/prevent-cheating/faculty/exam-
rules.html#Assign-seats

• Only available for selected large rooms.
But if your room has numbered seats, you can 
make your own spreadsheet in this format.

SOLIS 104 (excerpt)

https://academicintegrity.ucsd.edu/take-action/prevent-cheating/faculty/exam-rules.html


Seating chart irregularities
If any are listed, check seats to see if they still apply

AIO spreadsheet for Center 101 Facilities seat map of SOLIS 104



DIY room maps: APM B402A

EAST	HALF Front	chalkboard WEST	HALF

Utilities
Proctor	and	collecting	tests

A1 A2 A3 A4 A5 A6 A7 A8 A9 A10 A11 A12

B1 B2 B3 B4 B5 B6 B7 B8 B9 B10 B11 B12

C1 C2 C3 C4 C5 C6 C7 C8 C9 C10 C11 C12

D1 D2 D3 D4 D5 D6 D7 D8 D9 D10 D11 D12

E1 E2 E3 E4 E5 E6 E7 E8

B402A	Door	(main	entrance) B402B	Door

• New rooms and dept-controlled 
rooms may not have seating 
charts or numbered seats

• DIY numbering may be doable:
• Go into the room early to 

tape on seat #s,
row/column #s, or names

• Or show a slide with a 
drawing of the seats with 
the students’ names



Check out the room in advance

• Visit the room before making the seating chart, when it’s empty.
If it isn’t free before/after your class, check the room schedule.

• Bring printout of seating chart drawing. Or take photos or draw 
your own.

• Check if issues noted on the drawing or spreadsheet still apply.

• Also check for broken seats, missing seat labels, etc.
You can report that they need repairs, but you may need to
avoid assigning them.



Check out the room in advance

• Decide where to collect exams.

• Some rooms have a large table or stage in front.

• If you’re using front row desks to collect exams, then leave a 
buffer around them. Don’t assign those seats or nearby seats.



Seating Charts

• Getting seating charts
• Special requests: accommodations, left-handed seats, … (Part 1)
• Every other seat, two rooms, etc.
• Random seat assignments
• Special requests (Part 2)



Sample announcement 2 weeks before first exam
(Don’t just use as-is; be sure to adapt it)

We will be assigning seats for the midterm, and some 
students will be assigned to a second room. Please watch for 
an announcement with your room and seat assignment.

If you would like to be assigned a left-handed desk or have 
other seating issues, please email the instructor by [date].

Accommodations: If you have an AFA letter from OSD and 
have not yet notified the instructor, please send it now.



Left-handed seats

• If your room has left-handed (LH) seats, announce this ~2 weeks in 
advance (lecture, Canvas Announcements, exam announcement,…)

• Keep list of LH students for other exams but adjust for drops

• Manually assign those students to LH seats. Remove other LH seats 
so they’re not assigned to RH students (unless class is too large)

• I focused on LH seats, but sometimes people have other seating 
requests, usually due to accessibility



Seating Charts

• Getting seating charts
• Special requests: accommodations, left-handed seats, … (Part 1)
• Every other seat, two rooms, etc.
• Random seat assignments
• Special requests (Part 2)



Seating chart variations

• Work out a seating pattern based on # of students vs. # of seats
• Low occupancy: Every other seat and/or row
• Around 2/3: Skip every 3rd seat or every 3rd row
• High occupancy: May still be able to work out a pattern

• Multiple rooms
• Work out how to split it up (by lecture/section, last name, or arbitrarily)
• Include both the room and seat number in a single “Comment”:

Comment for big room (with seat #s): “Room SOLIS 104, Seat A-1”
Comment for small room (no seat #s): “Room SOLIS 109”



Center 212: Sample plan, 81% of capacity
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• Room: 146 seats    (128 RH, 16 LH)
• Class:  118 students (113 RH, 5 LH)
• Too many students for every other 

seat or every other row
• Crossing out most of D & G gives 

proctors easy access to most 
students to check IDs, answer 
questions, etc.
• Also crossed out extra LH seats



Seating Charts

• Getting seating charts
• Special requests: accommodations, left-handed seats, … (Part 1)
• Every other seat, two rooms, etc.
• Random seat assignments
• Special requests (Part 2)



Assigning seats

• Download a Canvas roster, keep the first 4-5 columns but delete 
the others, and add a “Comments” column

• Add seats to it; several possible methods:
• Manually (like shown before)
• AIO’s instructions for TritonEd rosters (from Prof. Emily Tang in Economics)
• My instructions in this presentation
• Write a program to automate it

• Upload it to Canvas



Random seat assignments

• Get AIO spreadsheet of seat #s or make a similar file yourself.

• Make a copy of their file; you’ll be modifying it:
Original: center-hall-212.xlsx
Your copy: randomized-center-hall-212.xlsx

• OPTIONAL (more info later):
• In this file: delete seats you’re not using, like front row seats; extra left-

handed seats; or every other seat or row.
• In the roster: delete accounts that don’t need seats, like UCSD staff.

But keep “Test Student” and assign a fake seat, to check the student view.



Open your copy of AIO’s seat spreadsheet



OPTIONAL: Format the seat # like
“Seat: A-1” or “Room: Center 212, Seat: A-1”

Student view in Canvas gradebook



OPTIONAL: Format the seat # like
“Seat: A-1” or “Room: Center 212, Seat: A-1”

Enter column name
“Formatted”

Enter a formula. Cell C3 has seat number “A-1”

For one room:
=CONCAT("Seat: ", C3)

For two rooms:
=CONCAT("Room: Center 212, Seat: ", C3)



OPTIONAL: Format the seat # like
“Seat: A-1” or “Room: Center 212, Seat: A-1”

Success!



OPTIONAL: Format the seat # like
“Seat: A-1” or “Room: Center 212, Seat: A-1”

Copy & paste the formula
down the rest of the column



Create a column of random numbers

Enter column name
“Randomize”

Enter formula
=RAND()



Create a column of random numbers

Random decimal 
between 0 and 1

NOTE: The random value
may keep changing!
Don’t worry about it.



Create a column of random numbers

Copy & paste the formula
down the rest of the column



Sort the rows using the random # column

Select all the seat rows
On “Data” menu, pick “Sort…”



Sort the rows using the random # column

Select to sort by the column 
named “Randomize”



Sort the rows using the random # column

It’s in a new order!

The random numbers have
changed again; don’t worry
about it.



Room spreadsheet Roster spreadsheet

Copy to roster spreadsheet using
PASTE SPECIAL as VALUES

CUT or COPY as many 
seats as you need

PASTE SPECIAL as VALUES
(ordinary PASTE won’t work)



Room spreadsheet Roster spreadsheet

Copy to roster spreadsheet using
PASTE SPECIAL as VALUES

CUT or COPY as many 
seats as you need

PASTE SPECIAL as VALUES
(ordinary PASTE won’t work)



Roster spreadsheet

Save roster as CSV and upload to Canvas



Seating Charts

• Getting seating charts
• Special requests: accommodations, left-handed seats, … (Part 1)
• Every other seat, two rooms, etc.
• Random seat assignments
• Special requests (Part 2)



Special seat assignments (OPTIONAL)

• Make groups on your roster:
• Main group [at the top here]
• OSD separate room
• Left-handed
• Other special seats in room
• Staff on roster [or delete them]
• Section A05 in overflow room

• Move people into their group

• Also make groups on the seat list spreadsheet:
Right-handed, Left-handed, Empty, Broken, …

and randomize RH/LH sections separately



Special seat assignments (OPTIONAL)

For each roster group needing seats:
• CUT from seat list spreadsheet
• PASTE SPECIAL as VALUES into roster

• When doing multiple copy & pastes, I recommend 
CUT instead of COPY to avoid assigning a seat twice.



Special seat assignments (OPTIONAL)

• Save roster as .xlsx so you can format it neatly 
for printing. But also export as CSV for Canvas.

• Blank rows are fine when uploading.

• The group title rows “OSD separate room”, … 
should only have text in the “Student” column; 
leave the other columns blank.



Next up: Exam logistics
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Part 3. Assigned seats exam logistics

• Pre-counting stacks of exams

• Getting seated & handing out exams

• Roster printouts

• Checking IDs



Optional prep before exam:
Pre-counting stacks of exams

• Pre-count exams into stacks to hand out quickly
(either number of assigned seats or number of physical seats)

• Optionally write seat numbers in the upper corner of each exam

• Bring extra exams as this may not go as planned (wrong seats, 
late arrivals, …)

Count Count Count

6

5

4

0

4

3

3

2

D

C

B

A

4

3

3

2



Sample announcement before handing out exams
Example A: If you marked seat #s on exams and skipped seats

Please sit in your assigned seat.
Do not switch seats without our permission.

Take the test with your seat # from the TOP of the pile.
Keep it face down until we announce to start the test.

If someone is late, place the test with their seat # on their 
desk. Colors will alternate and some seats will be empty.

You need to have out your exam booklet, UCSD ID card, pencils 
(or pens) and erasers, optional note sheet, and calculator.

No books, phones, laptops, smart watches, etc.
Disable and put away your phones and other devices.



Sample announcement before handing out exams
Example B: Packed rows, didn’t mark seat #s on exams

Please sit in your assigned seat.
Do not switch seats without our permission.

As exam booklets are passed out:
• Do not start until we say to.

• Instructions up, exams closed, until we say to start.

• Colors should alternate, including on empty seats.

You need to have out your exam booklet, UCSD ID card, pencils 
(or pens) and erasers, optional note sheet, and calculator.

No books, phones, laptops, smart watches, etc.
Disable and put away your phones and other devices.



Prep before exam: Printouts of roster

• Print rosters with name, PID, (sec. # if needed), seat #
• You can hide the other columns
• Make alphabetical order version and seat order version (stapled together)
• Bring several printouts of each for prof/TAs/proctors helping check IDs (and 

collect all the copies as they complete the ID checks)
• Optional: on exam day, make list of who dropped since seats were assigned

• If the room has sections, I organize the seat roster as:
left section rows A,B,C,…;    middle A,B,C,…;    right A,B,C,…



Checking UCSD ID cards / attendance

• Some faculty check IDs as students enter the room, or as they turn 
in exams (use alphabetical roster)

• I check IDs during the exam (use seat order roster)

• Proctors can split up room:
• Check IDs in left/middle/right sections;
• Or one proctor works front to back and another works back to front



Checking UCSD ID cards / attendance
Discrepancies

• Note any issues (alternate ID, no ID, wrong seat, late, absent, …)
• If multiple proctors check IDs, compare notes to reconcile discrepancies

• No ID: Maybe you or TA knows them. Check photo on Instruction Tools. 
Ask them to show name & PID on front of exam.

• Wrong seat:
• Before exam: Use alphabetical roster to help them find their seat

• During exam: I usually just note it but don’t move them, as it’s disruptive

• No shows: After checking all IDs, call no shows’ names, just in case



Next up: Putting the roster into seat order
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Part 4. How to sort the roster into seat order



Sorting roster into physical seat order
(Easy case: room with one section)

• In many rooms, the left-to-right order is simply:
A-1, A-2, …, A-10, A-11, A-12,
B-1, B-2, …, B-10, B-11, B-12, B-13,
…

• But this doesn’t sort as expected since it’s sorting as strings:
A-1, A-10, A-11, A-12, A-2, …, A-9,
B-1, B-10, B-11, B-12, B-13, B-2, …, B-9,
…



Sorting roster into physical seat order
(Easy case: room with one section)

Workaround:
• Add  a space before 1-digit numbers: “A- 1”
• But no space before 2-digit numbers: “A-10”
• Sorts as:

“A- 1”, “A- 2”, …, “A- 9”, “A-10”, “A-11”, “A-12”



Sorting roster into physical seat order
(Easy case: room with one section)

On the AIO spreadsheet, replace the “UNIQUE SEATING #” formula in C3 
(location may vary) and copy down the column:

• Original C3: =CONCATENATE(A3,"-",B3)
• Change to: =IF(B3<10,CONCATENATE(A3,"- ",B3),CONCATENATE(A3,"-",B3))



Left/Middle/Right sections
(Harder case)

• For passing out tests, and for checking IDs, you may want to
order the roster by left/middle/right sections.
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Facilities map of CENTER 212
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Theater numbering: Even / 100s / Odd
(not 1,2,3,… going left-to-right)

• Price Center Theater has even numbers on the left, odd on the 
right, and 3-digit numbers in the middle.



Sorting roster into physical seat order
Harder cases: Left/Middle/Right or “theater numbering”

First, put the seat list spreadsheet into the order you prefer:

• AIO seat spreadsheets are in this order (including PC Theater):
row A left-to-right,    row B left-to-right, …

• For rooms with left / middle / right sections, I prefer this order:
left A,B,C,…,    middle A,B,C,…,    right A,B,C,…

(requires manually rearranging the spreadsheet)



Add a seat “Sequence” column

Start with a renamed copy 
of the AIO spreadsheet, 
rearranged in the order you 
want



Add a seat “Sequence” column

Make a new column “Sequence”
and enter 1 for the first seat



Add a seat “Sequence” column

Enter a formula to add 1 as you 
go down the column.

In F4, enter
=F3+1



Add a seat “Sequence” column

Copy & paste the formula
down the rest of the column



Add a seat “Sequence” column

If we reorder rows, the 
sequence numbers won’t 
stay with the same seats, 
due to the formulas.



Add a seat “Sequence” column

Select whole column (click 
on “F”) and COPY it

If we reorder rows, the 
sequence numbers won’t 
stay with the same seats, 
due to the formulas.



Add a seat “Sequence” column

PASTE SPECIAL as VALUES
into the next column



Add a seat “Sequence” column

Column G:
Just numbers, no formulas

Column F:
Result of formulas



Add a seat “Sequence” column

Select column F and delete it



Add a seat “Sequence” column

Just numbers, no formulas



Add “Formatted” and “Randomize” columns
(same as before; see earlier video)

Create a “Formatted” seat column:
=CONCAT("Seat ", C3)

or: =CONCAT("PC Theater, Seat ",C3)



Add “Formatted” and “Randomize” columns

Create a “Randomize” column:
=RAND()



Add “Formatted” and “Randomize” columns

Copy & paste both formulas
down the rest of both columns



Sort rows by “Randomize” column

Select all seat rows

Use Data → Sort
and sort by the
“Randomize” column



Sort rows by “Randomize” column

It’s in a random order!



Room spreadsheet Roster spreadsheet

Copy seats to roster
Must copy TWO columns

CUT or COPY both columns
Sequence and  Formatted

for as many seats as needed

PASTE SPECIAL as VALUES



Room spreadsheet Roster spreadsheet

Copy seats to roster
Must copy TWO columns

CUT or COPY both columns
Sequence and  Formatted

for as many seats as needed

PASTE SPECIAL as VALUES

Column headers



Save it in TWO formats
Scenario: EXCEL saving to a local computer

1. Save roster as .xlsx format
• Roster is sortable by Student (alphabetical) or

Sequence (for seat order)
• Format (column widths, colors, bold, …), sort in either 

order, hide columns not needed on printout, and print

2. To make CSV file for Canvas:
• Delete Sequence column
• Save/Export/Download as CSV
• Edit → Undo (to restore Sequence column)

(if your spreadsheet doesn’t autosave,
you can exit instead of using Undo)



Save it in TWO formats
Scenario: Google Sheets / spreadsheet that autosaves

1. Google Sheets automatically saves it
• Roster is sortable by Student (alphabetical) or

Sequence (for seat order)
• Format (column widths, colors, bold, …), sort in either 

order, hide columns not needed on printout, and print

2. To make CSV file for Canvas:
• Delete Sequence column
• File → Download → Comma-separated values
• Edit → Undo (to restore Sequence column)



The End


